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Introduction 

The SiteCM Blog component allows you to create a simple blog. You can set up accounts to 

manage the blog and these accounts can create blog categories, and then add posts to them. 

You can also choose to allow people to leave comments on your posts or not.  

SiteCM Blog - a New User Interface 

The Blog component uses a new interface.  One of the key differences is that it is responsive 

and will expand to use larger monitors more effectively.  

 

 
 

The image above was taken at the minimum recommended resolution.  The image below was 

taken at a larger resolution and shows more text for the Title and Categories.  

 

 

 

The new Manager interface works best at screen resolutions over 1164 pixels wide but will work 

on smaller monitors as well.  

 

All of the screen caps in this document were taken at 1164 pixels except where noted.  Any full 

screen images have been shrunk to fit the documentation. 

 

  



 

 

 

Blog Component - Landing Page 

 

When you log on onto the Blog Manager you will be at the Posts landing page.  

 

 
 

A. SiteCM Content Menu:  

○ This menu is used to navigate within the SiteCM / CommerceCM Manager itself.  

B. SiteCM Blog Menu:  

○ This menu is used to manage your SiteCM Blog. 

C. SiteCM / CommerceCM Manager Menu: 

○ This menu is used to navigate to various available components within the SiteCM 

/ CommerceCM Manager itself.  

D. Admin Menu | SiteCM Help | Administrator Name: 

○ Admin Menu is not available for selection. It is used by ideaLEVER Solutions.  

○ SiteCM Help menu is used to learn more about SiteCM / CommerceCM. 

○ Name of current Administrator logged into SiteCM / CommerceCM. 

E. Blog Post List: 



 

 

○ List of all blog posts created. This section also provides Blog Post filter options, 

and a search feature. Paging is also available at the base of the Blog Post list. 

SiteCM Blog Menu: 

The SiteCM Blog Menu is used to perform the following:  

 

 

● Posts: These are the articles that you write for your blog 

● Categories: You can create categories and 

subcategories to organize your blog by topic 

● Comments: If you allow people to comment on your 

blog, this is where the comments will be listed. You can 

read submitted comments, approve or deny them, and 

reply to them. 

● Authors: You can set up accounts to write blog posts.  

● Settings:  Configure how many posts to show per page, 

whether to accept comments and more! 

● Import: Import from WordPress.  

 

 

Creating a Blog Post 

 

From the Posts Landing page, Mouse over the “New” button at 

the top left and select the “Post” option.  This will open the 

interface for creating a new blog post as shown below.  If you 

change your mind you can hit Cancel or click the Blog link in 

the left menu to return to the landing page. 

 

 

  



 

 

 

The Blog Post Editor 

 

 
 

The left hand main pane represents the Blog Post Editor. The right hand pane provides the Blog 

Post’s properties. Everything you need to create your blog post is on this one page. 

Field Summary: 

 

Post Title: The title of your blog post will show up on the front end of your blog as a link in all 

category pages.  It is also used as the browser title by default and in the results on search 

engines so consider keywords and make it intriguing!.  

 

Preview: This currently only works after a post has been activated and published.   

 

Cancel: Cancel the creation or edit of the blog post. 

 

Save: Save any changes made to the Blog Post within SiteCM for future editing as a draft. 



 

 

 

Save and Close: Similar to the Save button, the Save and Close button will save your changes 

to the blog post as a draft, and will then will close the Blog Post editor.  

 

Author: This single selection box is used to select the Author or Writer of the blog post. If no 

Author is selected, the Author of the Blog Post will be “Anonymous”.  

 

Filename: This will be created automatically after you tab (or click) outside of the Title field 

itself. SiteCM will replace all spaces within the provided title with dashes instead, and will 

remove all special characters. Following this automation, you can edit the filename manually if 

you prefer.  

 

Note: A blog post filename cannot contain spaces or special characters other than the 

underscore ( _ ) and dash ( - ).  Filenames must also be unique. 

 

Page Template: In most cases your Blog will be set to use a default template that will be pre-

selected. If you have additional templates you can change the selection. 

 

Post Content: The editor is the familiar SiteCM / CommerceCM page editor, simplified for use 

within the SiteCM Blog. There are no Snippets or Content Blocks tools available for blog posts. 

The remaining tools available are identical in nature and management to those found within the 

SiteCM Page Editor. Design and HTML view are available for Post Content. 

 

Toggle Full Screen Mode:  

 

The only addition to the editor for Blog is a Toggle Full Screen Mode icon, found 

within the bottom row of the blog editor tools menu. Clicking this icon makes the 
editing window itself go the full width of your screen, flowing over the properties 
section on the right hand side, maximizing the view you have of the Blog content area 
itself. Clicking it a second time returns the blog editor to its default size. 
 

Permissions: If you have multiple User Roles or Membership you can set access permissions 

to the blog post itself. These controls are located below your Blog Post content area. 

Post Properties 

There are three sections for Post Properties: 

 

● Basic Settings 

● SEO Settings 

● Language  

Basic Settings 

These are the most important fields to fill out. 

 



 

 

Post ID: Until the post has been saved it will display a Post ID of -1.  It will be set automatically 

by SiteCM.  

 

Short Description: This is used in some templates on Category & 

landing pages.  It can be a sentence or two that should intrigue your 

users and give them a reason to click through to the full blog post. 

 

Category:  By default all new Posts appear in the “Blog” category.  You 

can click the “+” symbol to see a full list of existing categories. Click the 

appropriate check box to select or deselect any category.   

 

  
 

If the category you need has not been created yet, you can click the link 

to create a New Category.  Specify a name and a parent category and 

click the Add New Category link.  The new category will be added to the 

list and it will be selected.  If you want your Category to be a top level 

category, select Blog as the Parent Category 

 

Tags: Tags are optional and are similar to Categories.  They are helpful 

for SEO and to help your site visitor navigate and find posts related to 

specific content.  Tags can be keywords or related words not found in the 

blog post.  Some templates will let users click a tag to find all posts that 

use the same tag. 

 

 
 

Featured Image:  A featured image is optional and will only display to your site visitors if your 

blog design includes it.  It is used differently in different templates.  The Featured Image can 

also be included in RSS feeds.  Featured Images must be loaded individually from your 

computer. 



 

 

 

Show in RSS: If your blog has been configured to generate an RSS (Really Simple 

Syndication) Feed, this checkbox is used to include the blog post 

in the RSS Feed itself.  

 

Allow Comments: Only visible if your blog has Comments 

Activated.  If they are, it is selected by default.  Deselecting this 

option will disable comments for the blog post. 

 

Active:  Checkbox indicating whether or not the post is active. 

 

Active Date: The date that the post will show up on your site. 

Default is today, but you can specify a date in the future. 

SEO Settings 

 

Browser Title: This will be prefilled with the Title of the Post 

created above.  You can edit it for length or keywords if you like. 

 

Search Engine Description: This will create your meta-

description.  It is an optional field.  

 

Revisit After & Robots:  These are optional settings that should 

only be adjusted if you understand the impact of the options 

presented. 

 

GoogleBot NoArchive: Check this box if you do not want search 

engines to index this page. 

 

Pre-Fetch URL & Custom Tags:  Rarely needed or used. 

Language 

The following options are only relevant if your site is configured to support multi language.  

 

Language: is used to set the ISO language of the blog post. Default is EN-US. 

 

Associated Post: is used to select the corresponding post written in a variant language of the 

EN-US post being created or edited. For example, to associate a FR-CA version of this EN-US 

post.  



 

 

Completing your Post 

 
 

The Blog Post Editor Menu depicted above is used to take action with your blog post.  

 

Preview: Preview what your blog post will look like once it has been published to your Blog. 

 

Cancel: Cancel any changes you have made to your blog post. 

 

Save: Save any changes made to the Blog Post as a draft within SiteCM for future editing.  

 

Save and Close: Similar to the Save button, the Save and Close button will save your changes 

to the blog post as a draft, and will then will close the Blog Post editor.  

 

Publish: Used to publish (or launch) the blog post itself, and any changes made to it. This will 

Activate your Post and make it show on the front of the site. 

 

Note: To publish the post at a future date, remember to adjust the Active Date field 

within Basic Settings, and then click the Publish button for your blog post. 

Editing a Blog Post 

Quick Edit Properties 

To update your Post Properties you can click anywhere on the line of the blog post itself to open 

the Quick Edit panel from the Right margin. 

 

From here you can update all of your post Properties. 

 

When you are done hit the Save icon.  Publish will save your changes, mark the post as Active 

and it will appear on the front end for your visitors. 

Post Edit 

If you need to update your Post contents, click the title of the Post to open the full Post editing 

window.   

 

If your Blog post is already active, you will have to hit “Publish” to make sure your changes are 

shown on the site. 



 

 

Categories 

The categories menu item of the Blog Menu is used to manage your website blog’s existing post 

categories.  

 

 

Editing an Existing Category 

To edit a blog post category, click on its name. This action then displays the Properties of your 

category, appearing on the right hand side of the Blog Categories pane itself. 

 

Category ID: provided by SiteCM Blog. This field is not editable. 

 

Name: This is used in the Navigation, the title on the Category index page and the browser title. 

 

Rank: Positions the Category in the list of Categories and Navigation.  If all Ranks are the same 

the Categories will be sorted alphabetically. 

 

Description: Is used in some templates at the top of the page of listings.  The field will expand 

as you add content. 

 

Parent Category: To create a sub category, click the + symbol in front of Blog and then select 

the Parent  



 

 

 

The buttons at the bottom of Properties Pane 

allow you to Delete the category, Cancel 

changes you have made to the category’s 

properties, or Save them.  

Comments 

The left navigation highlights that there is one new, unapproved comment. 

 

The landing page shows approved and unapproved comments 10 to a page from newest to 

oldest.  Each row shows the Comment Author, the full Comment and the current status, and the 

post it was in Response to.   

 

 
 

Using the -Filter- drop down at the top of the page allows you to limit the list to only show 

comments that are Approved, Unapproved, Deleted, and Marked as Spam.   

 

The search on the right searches an index of the Comment Author (name), Location, and 

Comment body and returns a list of all matching Comments.   To reset the list, click  the “clear” 

link that appears behind the search button. 

 



 

 

Checking the boxes on the right side of each 

comment row activates the -Actions-  menu 

and allows you to do bulk changes on all of the 

selected comments at once.  You change their 

approval status, Delete, or mark them as 

Spam. 

 

The “In Response To” column lists the post 

title.  You can click a link and View the post as 

a visitor in a new tab or Edit the post in a new 

tab.  You can also click a link to view all 

comments on the post. 

 

Rolling your mouse over the comment row reveals controls to process the comment as shown in 

the second row.  Your options are to Reply, Delete, or Mark as Spam. 

 

● Clicking the “unapproved” label changes the comment to “approved” and the label to 

green. 

● Clicking Delete removes the comment from the list and it can only be viewed using the 

filter. 

● Clicking Reply slides open the reply window from the right.  The comment you are 

replying to remains highlighted. A Private Reply is sent as an email to the author of the 

comment.  

 



 

 

 

Authors 

Blog Authors are managed within 

SiteCM Users. Clicking the 

Authors menu item in the Blog 

menu navigates you to this section 

within SiteCM.  

 

In order to be listed in the Author 

drop down in the Blog manager, 

the User account must be part of 

the “Blog User Role”.  This is true 

even for Administrators.  To select 

a second Role, use Ctrl+click.  

 

Note: ideaLEVER solutions will 

configure this new User role for 

you upon the addition of the Blog 

Component to your SiteCM / CommerceCM license. 



 

 

 

Note: If a User Account is only intended to be used as a Blog Author and has been assigned 

the Blog User Role, the Default Page field depicted above for your user must be set to “Blog”.  

This will ensure that when the blog author logs in to SiteCM using their login credentials, they 

are taken directly to the Blog landing page itself. 

Settings 

 

Note: This section is only available to site Administrators, not Blog Authors.  

Common 

SCM_Blog_PageID:  The page id of the SiteCM Link-To page in the navigation that 

links to the Blog Landing Page (/blog/default.htm). Blog categories will be automatically 

added under this menu item. 

 



 

 

Blog_Dynamic_Summary_MaxLength: The default length of the summary content 

when it is automatically generated from the main blog content. 

Landing 

SiteCM_Blog_Landing_DefaultPageSize:  The default number of blog posts that show 

up on initial load of the blog main page. 

 

SiteCM_Blog_Landing_PostsPerPage: The available page sizes for the blog posts 

that show up on initial load of the blog landing page, use -1 for "show all". 

Category 

SiteCM_Blog_Category_DefaultPageSize: The default number of category blog posts 

that show up on initial load of a category page. 

 

SiteCM_Blog_Category_PostsPerPage: The available page sizes for the category 

blog posts that show up on initial load of a category page, use -1 for "show all". 

Author 

SiteCM_Blog_Author_DefaultPageSize: The default number of author blog posts that 

show up on initial load of an author page. 

 

SiteCM_Blog_Author_PostsPerPage: The available page sizes for the author blog 

posts that show up on initial load of an author page, use -1 for "show all". 

 

SCM_Blog_Author_FirstNameOnly: Sets whether to display first name only of blog 

authors, true or false.  

Comments 

SiteCM_Blog_Default_AllowComments: turn on(true)/off(false) the default state of 

"Allow Comments" check box for new blog postings, true or false.  This can be 

overridden manually on individual posts. 

 

SiteCM_Blog_Comments_AutoApprove:  CAUTION: if true, the comment will 

immediately display on the website which could result in spam or profanity. 

 

SiteCM_Blog_Comments_DefaultPageSize:  The default page size on initial load of a 

blog posts comments. 

 

SubmitComment_AdminEmail_To_EN-US:  The "To" email address for the notification 

email that a comment was submitted. The notification email also gets sent to the author 

email. 

 



 

 

SubmitComment_AdminEmail_Subject_EN-US:  The subject line for the notification 

email that a comment was submitted. The notification email also gets sent to the author 

email. 

 

SubmitComment_Template_EN-US:  The html (or path to html file) for the content of 

the notification email that gets sent to the admin/author that a comment was submitted. If 

not defined, then a plain text email is sent with all the comment details. The template 

supports the following variables: %name%, %email%, %location%, %comment%, 

%postingtitle%, %postingcategories%, %commentlink%. If using an external file the 

value MUST be a local file and start with /. 

Replies 

Blog_Reply_From_Name: The default moderator name, used to prefill the "Reply 

Name" field that is used in the "From" field of the reply email sent to the Commenter. 

 

Blog_Reply_From_Email: The default moderator email, used to prefill the "Reply 

Email" field that is used in the "From" field of the reply email sent to the commenter. 

 

Blog_Reply_Template_EN-US: The html (or path to html file) for the content of the 

reply email that gets sent to the Commenter. The template supports the following 

variables: %date%, %name%, %email%, %location%, %comment%, %reply%, 

%authorname%, %replydate%, %postingtitle%, %postingcategories%,%postinglink%. If 

using an external file the value MUST be a local file and start with /. 

 

Blog_Reply_Subject_EN-US: The subject line of the reply email that is sent to the 

Commenter. 

 

Blog_Reply_CopyTo_EN-US: An email address where a copy of the reply email can 

also be sent too.  

 

Blog_Reply_Link_Format_EN-US: The link that appears in the reply email if the reply 

is not private. This replaces the %postinglink% variable in the reply template. You can 

use other variables, eg. %postingtitle%. 

 

Blog_Reply_CommentDate_Format_EN-US:  The date format used when displaying 

the date when the comment was submitted. 

 

Blog_Reply_Date_Format_EN-US: The date format used when displaying the date 

when the reply was submitted. 

 

Note: to save changes made to any field above, click the Update Settings button within 

the section containing the setting you have changed.   



 

 

Import 

 

The Blog Menu’s Import section is used to import a WordPress based blog into your SiteCM 

blog. The import process must first be activated for your website blog by ideaLEVER Solutions. 

Contact our support team at support@idealever.com if you do not see an import link in the blog 

menu, and you are interested in importing your WordPress Blog, into SiteCM.  

Importing from WordPress 

1. Login to your Wordpress Site. 

 

2. From Wordpress dashboard, select "WP Admin" (or add /wp-admin to the end of your 

site’s url). 

 

3. In the WP Admin dashboard, go to Tools → Export 

 

4. Select "Start Export" from the Free Export section of the page. 

 

5. From the "Choose what to export" radio buttons, select "All content". 

 

6. Click the "Download Export File" button to download a .xml file of your blog’s content. 

 

7. In the SiteCM manager, go to Blog → Import. If you don’t see the link in the menu, then 

the import feature has not yet been activated on your SiteCM license. 

 

8. Choose the .xml file that was downloaded during the export from Wordpress. 

 

9. Click the "Upload" button beside the filename to generate a report about the Authors, 

Posts and Categories found in the .xml 

 

10. Click the "Process" button to import the data found in the .xml file. Posts and Categories 

that are already present in your SiteCM blog are not re-imported. 

 

SEO and Google Indexing 

Blog Transition from WordPress to SiteCM 

Redirecting URL’s 

In order to preserve Google indexing and SEO, all blog articles will need to be 301 redirected. 

As the blogs are all on a Linux server running Apache, the simplest (and quickest) solution is to 

use .htaccess redirection. It’s a server file, and the first thing that’s checked. It doesn’t matter if 

mailto:support@idealever.com


 

 

WP is active or not to work. The following steps need taken to transition from the WordPress 

blog.domain.com to the new SiteCM blog after the import is complete. 

 

1. Download this plugin, 

https://drive.google.com/open?id=0B4aaYRVhWDNsdnVEb1RBTlJycEU  

 

2. Login to your WordPress blog 

 

3. Check URL format. 

a. If the blog uses the standard URL format ie. blog.domain.com/blog-post-name/, 

then proceed to step 4. 

 

b. For non standard blog post URL’s ie. blog.domain.com/?p=123, 

blog.domain.com/category/post-name/, etc: 

i. Go to Settings > Permalinks 

ii. Change Common Settings to ‘Post Name’ 

iii. Save! 

iv. Check the bottom of the page to see if there are server permission 

issues. If there are, then copy of and paste the snippet given at the top of 

.htaccess file. 

4. Install the plugin 

i. Plugins > Add New > Upload Plugin 

ii. Choose File - the one you just downloaded, and install 

iii. When it’s installed click Activate Plugin 

iv. Go to Tools > Redirect to SiteCM 

 

5. Follow the remaining directions provided. 

 

An .htaccess editor is included to avoid needing ftp login credentials.  

 

Note: This may not work on older blog servers where permissions may be an issue. In that case 

access the WordPress Blog’s .htaccess file through FTP.  The .htaccess file is found in the root 

directory of your WordPress Blog. Edit it, and cut and paste the code from the above plugin. 

 

For non-standard URL formats it’s extremely important the rewrite rules go under the 

WordPress ones (after # END WordPress). If there the URL structure is the original WP default 

of /?p=123, then the .htaccess file will (most likely) not have any WP rewrite rules, and the 

SiteCM redirects can go at the top. 

Wildcard vs. Per-Post Redirect 

Wildcard is the simplest, and will leave access to the WordPress admin if needed. It also covers 

any case where someone may follow a bad link to the old blog. But if there’s any concern, 

they’ve created a non WP standard custom url strucuture, or the blog.domain.com is being used 

for other purposes as well, then the per-page redirects just contains the blog posts. 

https://drive.google.com/open?id=0B4aaYRVhWDNsdnVEb1RBTlJycEU


 

 

 

 

For any additional support or training related to your new SiteCM Blog Component, please 

contact us as support@idealever.com 
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